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END USER LICENCE AGREEMENT 

All software products from RMR Software Limited are made available under the terms of the "End User 
Licence Agreement" (EULA) set out in the following sections.  
 
Notice to users: Carefully read the following legal agreement. Use of the software provided with this 
agreement (the "SOFTWARE") constitutes your acceptance of these terms. If you do not agree to the 
terms of this agreement, promptly remove the SOFTWARE together with all copies from your computer. 
User's use of this SOFTWARE is conditional upon compliance by user with the terms of this agreement. 
 
The software is protected by copyright law and international treaty provisions. You acknowledge that no 
title to the intellectual property in the software is transferred to you. You further acknowledge that title 
and full ownership rights to the software will remain the exclusive property of RMR Software, and you 
will not acquire any rights to the software except as expressly set forth in this licence. You agree that any 
copies of the software will contain the same proprietary notices which appear on and in the software. 
 

GRANT OF LICENCE 
 
This RMR Software Licence Agreement ("Licence") permits you to use one copy of the RMR Software 
product downloaded, which may include user documentation provided in electronic form 
("SOFTWARE"). The SOFTWARE is licensed to a single user. The SOFTWARE or its component parts 
may not be separated for use by more than one user at any one time.  However, you may install the 
SOFTWARE on more than one computer, provided it is solely for the use of the licensee. 
 

REVERSE ENGINEERING 
 
You agree that you will not attempt to reverse compile, modify, translate, or disassemble the software in 
whole or in part. 
 

DISTRIBUTION 
 
Webmasters, platform manufacturers, dealers, distributors, agents, publishers or any other third party 
are permitted to copy or distribute the SOFTWARE, provided it remains in the same format as the 
product available from the RMR Software Web Site.  It is NOT permitted to copy or distribute any of the 
component parts of the SOFTWARE. Establishing an Internet link to the RMR Software web site is 
permitted, and is encouraged, in order to facilitate access to the SOFTWARE.  

COPYRIGHT 
 
The SOFTWARE (including any images and text incorporated into the product) is owned by RMR 
Software and is protected by copyright laws and international treaty provisions. 
 

LIMITED WARRANTY 
 
To the maximum extent permitted by applicable law, RMR Software disclaims all warranties, either 
express or implied, including but not limited to warranties of merchantability and fitness for a particular 
purpose. In no event shall RMR Software or its suppliers be liable for any damages whatsoever 
(including, without limitation, damages for loss of business profits, business interruption, loss of 
business information, or other pecuniary loss) arising out of the use or inability to use this RMR Software 
product. 
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Using this Manual 

This manual takes you through the basic aspects of using RMRTask, and leading into the optional 
modules, advanced functions and configuration options of the program.  Much of it is structured in 
the form of a tutorial that you can follow. 

Within the manual the menu options and entry fields are identified in bold text as View preferences.  
Cascading menu options and the title tab of multi-page dialogs are represented by a | symbol, as in 
View preferences | Task.  Required responses are identified in ‘quote marks’ showing what you 
should select or enter in the fields.  Keyboard shortcuts for the commands and options are identified 
with the notation Ctrl+K which means ‘hold down the Ctrl key and press K at the same time’.  Several 
screen images are also included to help identification of the information or the required actions. 

 
 

1. Introduction 

The comprehensive Agenda program built in to EPOC machines is fully adequate for scheduling 
appointments and keeping lists of to-do items. However, although you can have several To-Do lists, 
adding many related project tasks can make accessing and managing them in a structured manner 
quite difficult. 

RMRTask ‘Extended ToDo Manager’ has been designed as an alternative method of recording and 
managing your tasks (a.k.a. To-Dos, W3s (who, what, when), action items etc.) that have to be 
accomplished, whether at work, at home, for hobbies or for personal goals. It allows you to use the 
principles of good time management, namely breaking down large projects into tasks of manageable 
size, categorising and setting priorities for tasks, sorting and ordering them, and being able to see 
progress, results and accomplishments. 

RMRTask allows sub-prioritisation of tasks, and by categorising on three levels (Groups, Projects 
and Types), allows you to quickly see lists of outstanding items and organise your tasks for optimum 
time management. 

This is the EPOC version of our S3a/c/mx program S3ATASK. The inspiration originally came from a 
program called TODO, written in 1992 by John Whiting of Lexsoft for the Psion S3, to make up for 
the limitations of the built-in Agenda. We acknowledge John' s efforts in designing that original 
program. 

Working through the Menu commands will show you the capabilities of the program, but to get the 
best out of it, the following description takes you through the basic functions and explains some of 
the finer details of operation. 
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2. Creating Task Groups 

Task Groups are the first major sub-division, and any number of Task Group files can be created and 
used how you wish. Each file will appear as (and can be opened from) a document file showing the 
program icon in your chosen Documents folder. Use different Task Groups to contain completely 
unrelated and independent lists of tasks, for example: one Group for monitoring projects and general 
to-dos at work, one for listing jobs that need to be done at home, another for personal goals you want 
to accomplish, and yet another for keeping track of items for pastimes, clubs etc. 

Start the program by selecting the icon from the Extras Bar. 

The first time of use you will be requested to supply a Title for the Task Group, and define the file 
Name and Folder for storage. 
This title is presented bottom left 
of the main program screen and 
can be renamed at any time using 
Update group details Ctrl+R. 
Work through the information on 
the 'nag' screen - if you want to 
skip this screen you will have to 
register !! 

The initial setting is for the 
Toolbar to be showing. You can switch it off using the normal Psion method Ctrl+T if you want more 
screen space for task descriptions, or set it to left or right with View preferences. Also, try tapping 
the pen on various positions within the screen to see the effect. In each case we have tried to present 
the most logical dialog. Rather than detail all of the options, simply try it in the screens. 

The File menu gives the usual options for Create new task group Ctrl+N, Open task group Ctrl+O, 
Move group Ctrl+H to another folder, and Delete group Shift+Ctrl+D if you've finished with it. Note 
that you must delete, move or rename Group files from within the program not from the system 
screen, or the program will get confused. Individual Groups can be Password protected if required 
with Shift+Ctrl+Q. 

 
 

3. Creating Categories 

The first thing to do before trying to enter any tasks is to define a few Project and Type categories 
using Shift+Ctrl+J. This is one of the first major differences of the program from Agenda To-dos, the 

idea being that by further categorising 
tasks at these levels you have greater 
visibility and flexibility in their 
management. You can then Sort and 
Filter your to-dos to identify all the related 
items (see section 6). 

Project categories can be anything you 
like - jobs, projects or clients at work, 

hobbies or maintenance at home, etc. Type sub-categories more specifically would be the activities 
involved - email, phone, letter, purchase, assigned people's names etc. However, the system is 
flexible so tailor them to suit your needs. 

Both sets of Categories can be defined to apply Globally to all Task Groups, or be group specific. In 
addition you can add a text description or notes to each category. 
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Categories can subsequently be renamed or completely removed using the appropriate Update and 
Delete options in the Categories menu. Note that you will 
need to use the Rebuild files function (see Section 8) if 
categories have been changed so that task associations 
can be re-indexed. If you don't wish to use or display the 
categories, options in View preferences | Usage allows 
you to disable either or both of these columns from entry 
and the screen. A further General Preferences | 
Terminology option lets you change the Project and Type 
titles themselves for each group. 

Categories can also be created from within the Enter new task dialog if you find you need a new one 
at time of entry. 

 
 

4. Entering Tasks 

 
Now you are free to put in some tasks, either from the Edit menu, shortcut key Ctrl+A, the Add task 
button on the Toolbar, or just by pressing Enter. First enter a Description for the task, which can be 
up to 100 characters long. Then go through the rest of the dialog entering the Due date you wish to 
complete the task by (it defaults to today's date), select the required Priority, and choose Project 
and Type categories from those you have defined. Leave the Dated, Alarm, Repeat, Agenda, Links 
and Text (extended description) options, we'll cover those and the various priority schemes later. 
Press Enter or tap the OK button when the details are correct. 

The task will appear in the list with the fields completed. Now go on and enter some more tasks, 
giving them different Due dates, Priorities, and assigned to different combinations of categories. 
Unlimited tasks can be entered per Group, although only 20 entries can be made in the unregistered 
version. The task you are on and the total number of tasks in the Group is indicated by a counter on 
the top line of the screen, together with the current date and 
time. 

For those tasks that you want to enter just as a reminder to 
do "sometime", you can make them undated or unprioritised 
(or both). For undated tasks untick the Dated field in the 
New task or Update task dialogs. For unprioritised tasks set 
the Priority to None. They will then show on screen with 
dashes in the date and/or priority fields, and will sort as low 
order entries at the end of the Task Group.  

Task entries can be updated if you make a mistake, or to 
change any of the attributes, by moving the highlight to the 
description and using Update task Ctrl+U from the Edit 
menu, the Toolbar button, or the Tab key. Note that the Task 
Update dialog has an additional field that has recorded the original Entry date of the task (the 
original Entry time is also shown if that Preference has been turned on). If you have similar tasks to 
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perform, entries can be Copied using Ctrl+Y which takes you to a dialog to specify the Task Group to 
copy to, and then the Update dialog to make any necessary changes. This function also allows you to 
completely Move the task to another Group. Alternatively, Ctrl+G will allow you to Enter last task 
again. 

Tasks can be completely removed if you don't want them. Using Delete task Ctrl+D will show a 
dialog allowing you to delete All, Single, Strikeout or Tagged tasks, while using just the Delete key 
will delete only the selected task. Note that all records of deleted tasks are lost. 

There are Backup Shift+Ctrl+B and Restore Shift+Ctrl+R options in the Tasks menu. Use these to 
keep a spare copy of your data on the Psion for safety, and to reload them if ever necessary. 

 
 

5. Extended Notes, Alarms, Repeats and Linked Files 

Tasks can be set with various further attributes to aid in their management. 

Extended Notes 

Extra notes or details can be added to tasks. Selecting the Text (Extended Description) page when 
entering a new task will take you to a memo window where you can make further notes about the 
task up to 1000 characters. Alternatively, use the Spacebar or Shift+Ctrl+Z on an existing task to 
view, edit or create an Extended description. 

Tasks with Extended Descriptions are identified with a symbol in the X column. 

 

Alarms 

By selecting the Alarm page in the New task or Update task dialogs you can specify the time and 
days previous for an alarm to sound as a reminder. The alarm itself will be passed to and handled by 
the built in Time application which allows up to 8 Alarms to be set. 
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Tasks set with an alarm are identified on screen with a symbol in the A column, and can also be 
toggled on/off with just the A or M keys (but not if these single keys are used for priority changing). 

Repeats 

The Repeat page in the New task or Update task dialogs allows you to set a Repeated entry. 
Repeats can be set for various Periods either daily, weekly, monthly, annually or for last day in the 
month. With an appropriate Interval, you can schedule the task to occur every 3rd day, 2 weekly, 
monthly, quarterly etc. When you complete such a task you will be given the option to re-install the 
task again in the group with the next Due date. 

Tasks set with a repeat are identified with a symbol in the R column, and can also be toggled on/off 
with just the R key. 

 

Agenda 

By selecting the Agenda page in the New task or Update task dialogs you can pass the Task entry 
to your normal Agenda file. This can be as a Timed entry, a ToDo entry or Anniversary with date, 
start and end time as appropriate. Note that each Task group can be associated with a different 
Agenda ToDo list (configurable from General preferences). 

Tasks set for Agenda are identified with a symbol in the G column. Within your Agenda the entry will 
be prefixed with the name [Task] and have an entry symbol (both configurable from Preferences). 
Optionally you can automatically delete these Agenda entries when the task is deleted or archived. 

 

Links 

By using the Links page in the New task or Update task dialogs you can link a task to an existing 
Word, Data, Sheet or Agenda files. Tasks with linked files will be identified with an appropriate W D 
S A letter in the L column. 

The linked file can then subsequently be viewed by highlighting the task and using the 
Shift+Ctrl+W,T,E,N options in the View menu. This is designed as a shortcut to save you pressing 
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the system button and navigating to the files etc. If you use these View options on a task that does 
not have a defined linked file, a dialog will give you options to Create a new file, or Link to an 
existing file. 

 
 

6. Viewing, Sorting and Scheduling Tasks 

Moving around the Task Group to select, view or change tasks is easily accomplished using the pen, 
up/down cursor keys or buttons. In addition, Fn+PgUp and Fn+PgDn or tapping on the slider bar will 
move you to the top or bottom record on screen respectively, while Fn+Home and Fn+End will move 
you to the top or bottom entry in the file. The Jump to option lets you to go straight to a specified 
date. 

As time progresses and tasks become current, the Due Date on screen will change from showing the 
future date to the days of the next week and then 'Today'. When the Due Date has passed and the 
task has become overdue it will then change to bold text as a strong reminder. (All configurable in 
View preferences). 

If tasks have been set to Auto Priority, their priority will automatically increase from ‘low’ to ‘med’ to 
‘high’ as the Due Date approaches, according to the schedule defined in General preferences. 

The tasks on screen can be sorted in ascending or descending 
order by Date, Priority, Description or either Category, by tapping 
on the appropriate column header title or by using Sort tasks. 
The latter method gives you the option of sub-sorting on 2 fields, 
so that sorting is extremely flexible, allowing you to tailor the 
screen order to your needs. In addition, the sorting method can be 
different for each Task Group, and is identified on bottom right of 
the screen.  

 

The complete task list can be filtered using Filter tasks 
Ctrl+F and selecting the required include/exclude 
method. Filtering can be on - project and type 
categories, priority, attribute (strikeout or in-progress), 
text (in description and extended description), and date 
(today, next week or a date range). These work 
individually or in combination to display only those 
entries that match the filter criteria. The filter(s) set are 
indicated at the bottom of the screen, and can 
be turned off by using Ctrl+F again or more 
simply by just pressing Esc. 

Ctrl+I toggles the task description to italics. This 
typically identifies a Task in progress, but can 
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also be used to signify that it has been assigned to someone else, or is waiting for a reply. An 
Underline function Ctrl+L allows you mark tasks for any reason. In addition Display as bar Ctrl+B 
shows the task progress as a graphical bar with today's position relative to the entry and due dates. 
This can be scrolled down screen to show each task in turn. 

To aid you in modifying tasks as events unfold or for doing "what if" scheduling, many attributes can 
be easily changed without having to go through the full Update task dialog screen. 'Single key 
switching' allows the following: 

 W increase the Due Date by 1 day 
 Q increase the Due Date by 1 week 
 O decrease the Due Date by 1 day 
 P decrease the Due Date by 1 week 
 T set the Due Date to 'today' 
 N set the Due Date to 'None' (undated) 
 Number 1-9 change the priority (if numeric priorities are used) 
 Letter A-I change the priority (if alphabetic priorities are used) 
 H/M/L change the priority (if Hi-Med-Lo priorities are used) 
 0 (zero) make the task unprioritised 
 R toggle the repeat on/off 
 S toggle "task in progress" on/off 
 A or M toggle the Alarm on/off (if these letters are not used for priority changing) 
 L toggle underline on/off (ditto) 
 X reset time 
 Spacebar view, edit or create an Extended Description. 

[Note that +/- were used for date changing in the S3a version of the program, but the S5 keyboard 
doesn't have these as separate keys. We have therefore implemented O for date decrease on the 
basis that it is also the - (minus) key, and P for week decrease as this has = marked (multiple minus? 
:-) ). W and Q for the date increase just mirror these on the keyboard. Sorry the logic is a bit thin 
here!] 

If you prefer not to use these various forms of Single key switching, you can selectively turn them off 
in General preferences. 

Several of these functions can operate on multiple tasks by first 'tagging' them using Shift+Up or 
Down Arrow, when they will be marked with a » symbol (configurable in View preferences). A Clear 
tags function Ctrl+W is also available to remove tags. 
 
In addition to the above, if you want to quickly change the scheduling of tasks and force some to be 
due 'today', use the Reset to today option Ctrl+S. This can operate on a single task, all tasks, only 
those that are overdue, or those you have marked by tagging. 
 
 

7. Task Completion and Archiving 

 
As you complete tasks in real life, mark them as completed in 
the task list by striking them through with Strikeout Shift+Ctrl+X 
or the Toolbar button. Multiple tasks can be operated on by first 
'tagging' them using Shift+Up or Down Arrow. You will be asked 
to confirm the Completion date which defaults to the current 
date or can be changed if you actually completed the task 
previously. If the task had the repeat flag set, another dialog will 
ask if you want to Activate next repeat and confirm the Due date. Struckout tasks will then be 
moved to the top of the screen. 

If you find that the task is not really completed it can be Reinstated by using Shift+Ctrl+X again, and 
giving it a New due date and Priority. 
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Because the system will slow down if you have a large number of 
tasks in a Group, you should periodically remove those completed 
to free space. Use Shift+Ctrl+G to Archive them to a separate 
history file as a permanent record of completed tasks. Note from 
the dialog that you actually have various options available (Archive 
or Remove, on Single, All, Strikeout or Tagged), but for now use 
'Archive' and 'Strikeout' entries. 

Because this is the first time the option has been used, you 
will be prompted to create an Archive file. This will not occur 
in subsequent uses of this option. Now you will be asked to 
select which Archive File to use, although at the moment you 
only have a choice of one, and whether to Append or 
Overwrite. Again, this is a personal decision. Some people 
are happy to run just one Archive, others prefer a file for each 
Task Group. Some like to keep just the last set of records, 
others like to keep a complete record of everything. Create new archive files using Shift+Ctrl+F or 
from the File | More menu. 

Note that the Create new task group and Update group details dialogs allow you to specify a Link 
to archive where you can associate an archive file with a particular task group. 

The above is the normal Strikeout and Archiving method for removing tasks from the active Task 
Group. Alternatively you can Remove them (completely delete), or if you prefer, you can move tasks 
directly to the archive file at the time of completion without retaining them in the task group as 
struckout. Use the Action completed tasks option in View preferences | Tasks option to set this. 
Again multiple removal and archiving can be performed by first 'tagging' the tasks. 

Now look at the Archive file using Switch view, Ctrl+Q or the Toolbar button. The Archive screen 
simply displays previous task information with many of the same functions as the main screen. You 
cannot change any of the completed tasks, but you can use tagging and Delete them. You still have 
the Filter entries Ctrl+F option available, as well as being able to view the Extended descriptions 
with Spacebar or Shift+Ctrl+Z. 

There are also options to allow you to Unarchive tasks Ctrl+U back 
to a Task Group if you want to re-use them again. If you do want to 
run multiple Archive files, then the File menu gives you the 
appropriate Create, Open, Rename and Delete options. The 
Folder option allows you specify a different storage location for 
archive files if you want. Finally, if the file gets too large, it can be 
truncated by using Reset start date Ctrl+R. 

Return to the main Task Group screen using Switch view, Ctrl+Q, the Toolbar button or just Esc. 

 
 

8. Other Functions 

You can select a larger or smaller font using the standard Zoom In and Zoom out options, Ctrl+M 
and Shift+Ctrl+M, or the 'Zoom' silk screen icons. The smaller fonts will allow more text to be 
displayed in each field with less truncation. The font size (but not type) is screen specific, so you can 
have different zoom settings in each screen. 

If you have more than one Task Group or Archive file, there are various switching 
methods. Use Ctrl+O in both screens to open other existing Groups or Archives. The L/R 
arrow keys and buttons top left of screen will also cycle through Groups and Archives. 

The normal Printing menu is available in both the main Task Group and Archive screens with the 
usual printing options You can print task lists as displayed with or without filters set, and with or 
without their Extended descriptions and a Header. 
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If you have tasks that you enter regularly then they can be set up as 
Default entries. Use the Setup defaults option Shift+Ctrl+S to Add, 
Update or Delete your named pre-defined default tasks. Then use 
Enter default task Ctrl+C or just Shift+Enter to select and enter 
them in a task group. 

The same applies to Filters that you use regularly. The Setup 
defaults option also gives the option to Add, Update or Delete a 
variety of named pre-defined filters, which can then be used from 
the Default field in the normal Filter tasks dialog. 

Note that default tasks and filters are specific to a Task group, and 
up to 20 can be set up for each group. 

Also in this Setup defaults menu, you can specify the default Priority to apply when adding a new 
task in any group. 

If your todo items are time sensitive, a time column can be turned on for specific Task Groups, using 
the Use time option in View preferences | Usage page. When you enter tasks, the Entry time will 

then be recorded and shown on screen. This can be Reset to the current time with Ctrl+X. 
Alternatively, the General preferences | Settings page gives you the option of using time in the 
Task duration mode. Then when entering a task you can specify the estimated duration for the task 
to take, and subsequently use Ctrl+X to turn on the Start task time, and Ctrl+V to set the Finish task 
time. 

Task and Archive lists, with or without a filter 
applied, can be Exported to a text file in ascii 
<TAB> delimited or CSV formats. 

 

In the File | More menu, the Rebuild files option 
does some cleaning up of all the files. It 
compresses them, refreshes the Category titles, 
resets the internal pointers and rebuilds the 
indices. Use this option after you have Updated/Deleted a Category name, or whenever you think 
something is not quite right with the data files. 
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9. Program Preferences 

The program has been designed for extensive user configuration. Many preference options are 
available within the sub-menus as follows: 

View preferences, Ctrl+K 

 
Display: 
• Font sets either Times Roman or Arial for the screen display. 
• As various different Date Formats are used throughout the world, you can choose your 

preferred option from a range. 
• Show days of next week displays the Due date for the next 6 days as their name, rather than 

as a date. 
• Include today in Overdue shows tasks due 'today' marked as overdue. 
• Toolbar can be set to left or right of screen. 
• Header window allows the column titles to be presented as depressible buttons to indicate 

sorting, or as standard text. 
 
Tasks: 
• Action completed tasks setting allows you to define your preferred action for completed tasks: 

whether to use the Strikeout method or to Archive them directly. 
• Show overdue tasks in sets the way overdue due dates are presented, as bold, italic or normal 

text. 
• Show tasks in progress in sets the way descriptions of tasks marked as in-progress are 

presented, as bold, italic or normal text. 
• Show description in text view adds the task description to the title of the extended description 

window. 
 
Usage: 
• Use time displays an extra column to record the task entry time or a time duration. Note that if 

this is used, the description field will be appropriately shortened. 
• Use first & second category allows you to turn off each of the categories from the entry 

dialogs and screen display if you are not using them, or require more space for descriptions. 
• Hide future tasks allows you to remove tasks with future dates from view if you don't wish to 

see them until they become due. '+Hidden' will be annotated with the counter at the top of the 
screen as a reminder. 

 
Flags: 
• Individually turns off the Alarm, Repeat, Extended description, Links and Agenda attribute 

columns if you do not wish to see them, or require more space for descriptions. 
 
Symbols: 
• If you don't like the Symbols we have chosen to identify Alarms, Repeats, Extended 

descriptions, Agenda links or Tagged tasks, you can specify another character or copy from 
the Psion Special Character screen. An option is also available to reset them to the program 
defaults. 

 
Agenda: 
• Tasks passed to your Agenda can be shown with an entry symbol. This allows you to turn them 

off, or to specify the symbols used for Timed entries, ToDo entries and Anniversaries. 
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General Preferences, Shift+Ctrl+K 

 
Settings: 
• Prompt for repeat shows the Repeat dialog when repeated tasks are completed. Turning this 

off will automatically re-enter them without you being asked. 
• Time method normally shows the Entry time for the task when the Time column is enabled, but 

this option allows you to specify a Task duration time instead. 
• Default to undated sets the task entry dialog to initially be undated. 
• Tap on selected entry defines which action you prefer if a selected task entry is tapped, from 

Strikeout, Archive, Update or Task In progress. 
• Default alarm sound sets your preference for the alarm to be used. 
• Add/Update dialogs determines which style of Task entry dialogs are used, whether Multi-page 

with tab headers, or the standard buttons. 
 
Terminology: 
• Category titles. If you don't like the default "Project" and "Type" category titles, you can specify 

your own for each Task Group. 
• Prefix in Agenda allows the program name, a user-specified prefix, or no prefix, to identify 

tasks passed to Agenda. 
 
Archive: 
• Delete agenda link lets you remove any linked entries from Agenda when the tasks are 

archived. 
• Default archive If you run multiple Archive files, the program default is to open the Last used 

file. You can change that so it opens a specified Default file, asks you to Select which one, or 
opens the Linked file for that task group. 

 
Single Keys: 
You can individually enable 'single key switching' for: 
• Date change. Use the Q,W keys to increment Due dates, the O,P keys to decrease the Due 

dates, T to set a task to 'today', and N to 'undate' a task, 
• Priority change. Change priorities with alphabetic or numeric keys as appropriate to the priority 

system defined, 
• Repeat key. Enable task repeats with R key, 
• Alarm key. Enable task alarms with A or M key (note that these will not work if already in use for 

priority changing}, 
• Progress toggle. Toggle 'task in progress' with S key, 
• Reset time. Reset the 'task time' with X key. 
 
Keys: 
• Define the use of the <Enter> key and <Tab> Key for Entering or Updating tasks. 
• Escape sends to background sets use of the Esc key to send the program to the background 

(i.e. the program will no longer be the current application). 
• Hot key defines the Ctrl+Fn+letter key combination to bring RMRTask back to the foreground 

when open. 
 
Priority: 
• Manual settings. Define here your preferred system for each Task Group. Either numbers or 

letters can be used with up to 9 levels, or alternatively the simple Hi-Med-Lo. Note that 1, A and 
Hi are treated as highest priority. 

• Auto settings. The system allows you to set how many days previous to the due date, when a 
low priority task becomes medium priority, and when a medium priority task becomes high 
priority. Enable this for tasks by setting Priority to 'Auto' in the Add Task or Update Task 
dialogs. 

 
Agenda: 
• Define the name and location of your Agenda file applicable to each task group. 
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• Default start time and Default end time specify the duration times that will initially appear in 
the Agenda settings page of the Add task dialog. 

• ToDo list specifies which Agenda ToDo list is related to this task group. 
 
 
Finally, don't forget the Help database Shift+Ctrl+H which has much of this information and more 
details. 
 
 
 
Al Richey and Andy Waller 
RMR Software 
 
[Last Updated : May 2001] 
 


